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Disclaimer
Dimensional Insight, Inc. disclaims the implied warranties of merchantability and fitness for a 
particular purpose and makes no express warranties except as may be stated in its written 
agreement with and for its customer.
In no event is Dimensional Insight liable to anyone for any indirect, special, or consequential 
damages. The information and specifications in this manual are subject to change without notice.
Copyright © Dimensional Insight Inc., 1991-2019.

Trademarks
Microsoft®, Windows®, and Excel® are registered trademarks of Microsoft Corporation in the 
United States and other countries.
Adobe®, Acrobat®, and Distiller® are registered trademarks of Adobe Systems Incorporated.

Limited Warranty and Liability
Dimensional Insight, Inc. (DII) is the owner of the Software to which this documentation applies. 
The Software is subject to copyrights, patents and other intellectual property rights of DII, is 
furnished only under a license to use it, and no ownership rights are conveyed in the Software 
under any circumstances. License rights are set out in written license agreements entered into by 
all licensees either prior to delivery of the Software or prior to first use of the Software. No use of 
the Software is permitted unless the user has first agreed to the terms of the license. DO NOT USE 
THE SOFTWARE IF YOU HAVE NOT REVIEWED AND AGREED TO THE TERMS OF THE 
LICENSE.
THE SOFTWARE IS FURNISHED “AS IS” AND WITHOUT WARRANTY OF ANY KIND OR 
NATURE TO THE EXTENT PERMITTED BY APPLICABLE LAW. DII EXPRESSLY 
DISCLAIMS ALL WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, INCLUDING THE 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR PARTICULAR 
PURPOSE, SATISFACTORY QUALITY AND NONINFRINGEMENT, AND THEIR 
EQUIVALENTS UNDER ANY LAW OF ANY JURISDICTION. IF APPLICABLE LAW 
IMPLIES ANY WARRANTIES OR CONDITIONS WITH RESPECT TO THE SOFTWARE, 
ALL SUCH WARRANTIES OR CONDITIONS ARE LIMITED TO A PERIOD OF THIRTY 
(30) DAYS FROM THE DATE OF DELIVERY OF THE SOFTWARE TO THE LICENSEE.
DII DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE 
WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE 
WILL BE CORRECTED. FURTHERMORE, DII DOES NOT WARRANT OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
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SOFTWARE IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE. SHOULD THE SOFTWARE PROVE DEFECTIVE, LICENSEE (AND NOT DII, 
ITS DISTRIBUTORS, DEALERS OR EMPLOYEES) WILL ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.
SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF EXPRESS 
OR IMPLIED WARRANTIES OR CONDITIONS UNDER CERTAIN CIRCUMSTANCES, SO 
THE ABOVE EXCLUSIONS MAY NOT APPLY TO YOU. IF SUCH EXCLUSIONS DO NOT 
APPLY TO YOU, AND ONLY IN SUCH EVENT, YOUR SOLE REMEDY WILL BE, AT DII’S 
OPTION, REPAIR OR REPLACEMENT OF THE SOFTWARE OR A REFUND OF THE 
PRICE PAID BY YOU FOR THE SOFTWARE. THIS WARRANTY GIVES YOU SPECIFIC 
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS WHICH VARY FROM 
STATE TO STATE AND JURISDICTION TO JURISDICTION.
While efforts have been made to ensure THAT the program and its documentation are free from 
defects, under no circumstances and under no legal theory, whether tort, contract, or otherwise, 
shall DII, or its distributors, dealers or employees, be liable to you or any other person for any loss 
or damage sustained in connection with ANY ATTEMPT TO use the Software, including without 
limitation, any economic, consequential or other indirect loss or damage, even if DII has been 
previously advised of the possibility of such loss or damage. Some states and jurisdictions do not 
allow the exclusion or limitation of INCIDENTAL or consequential damages under certain 
circumstances, so this limitation and exclusion may not apply to you.

U.S. Export Administration Act: Restrictions on Exporting Software
The Software may include certain cryptographic software that may be subject to export controls 
under the U.S. Export Administration Act. The Software may not be exported to any country or to 
any foreign entity or “foreign person” to the extent prohibited under applicable U.S. government 
regulations. By downloading or using the Software, you are acknowledging and agreeing to the 
foregoing limitations on your right to export or re-export the Software, and are also representing 
and warranting that you are neither on any of the U.S. government’s lists of export precluded 
parties nor otherwise ineligible to receive software containing cryptography that is subject to 
export controls under the U.S. Export Administration Act.
If a version of DiveLine that uses encryption is running, administrators must be aware that 
allowing users outside the United States to access data via certain DI-Clients qualifies as exporting 
encryption software (either the client executable or the Java applet sent to the browser). Export or 
re-export of encrypted software must be in accordance with the Export Administration 
Regulations. Diversion of encryption software contrary to U.S. law is prohibited.

Third Party Licensing
The licensing below applies to the third party encryption library routines ONLY.
This product may include software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit (http://www.openssl.org/) [Copyright © 1998-2011 The OpenSSL Project. All rights 
reserved.]
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This product may include cryptographic software written by Eric Young (eay@cryptsoft.com) 
[Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.]
Below are the two licenses which cover the use of these routines.

OpenSSL Project License
-----------------------
Copyright © 1998-2011 The OpenSSL Project. All rights reserved.

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the 
OpenSSL License and the original SSLeay License apply to the toolkit. See below 
for the actual license texts. Actually both licenses are BSD-style Open Source 
licenses. In case of any license issues related to OpenSSL please contact 
openssl-core@openssl.org.

Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditions are met:

1.  Redistributions of source code must retain the above copyright notice, 
this list of conditions and the following disclaimer.

2.  Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution.

3.  All advertising materials mentioning features or use of this software 
must display the following acknowledgment: "This product includes software 
developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://
www.openssl.org/)"

4.  The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to 
endorse or promote products derived from this software without prior written 
permission. For written permission, please contact openssl-core@openssl.org.

5.  Products derived from this software may not be called "OpenSSL" nor may 
"OpenSSL" appear in their names without prior written permission of the 
OpenSSL Project.

6.  Redistributions of any form whatsoever must retain the following 
acknowledgment: "This product includes software developed by the OpenSSL 
Project for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OPENSSL PROJECT "AS IS"' AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE OPENSLL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
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LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young 
(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

Open SSLeay License
-------------------
Copyright © 1995-2011 Eric Young (eay@cryptsoft.com). All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the 
following conditions are aheared to.  The following conditions apply to all code 
found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just 
the SSL code.  The SSL documentation included with this distribution is covered 
by the same copyright terms except that the holder is Tim Hudson 
(tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code 
are not to be removed. If this package is used in a product, Eric Young should 
be given attribution as the author of the parts of the library used. This can 
be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, 
are permitted provided that the following conditions are met:

1.  Redistributions of source code must retain the copyright notice, this 
list of conditions and the following disclaimer.

2.  Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution.

3.  All advertising materials mentioning features or use of this software 
must display the following acknowledgement: "This product includes 
cryptographic software written by Eric Young (eay@cryptsoft.com)." The word 
'cryptographic' can be left out if the rouines from the library being used 
are not cryptographic related.

4.  If you include any Windows specific code (or a derivative thereof) from 
the apps directory (application code) you must include an acknowledgement: 
"This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
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THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or 
derivative of this code cannot be changed.  i.e. this code cannot simply be 
copied and put under another distribution licence [including the GNU Public 
Licence.]

Copyright © 2019 Dimensional Insight, Inc., 60 Mall Road, Burlington, MA 01803  
(http://www.dimins.com)
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Chapter 1
Introduction 1

How to Use This Manual 1
This manual is separated into five chapters:

• Chapter 1, Introduction contains an overview of the manual and a description of 
DI-Updater and its associated files. 

• Chapter 2, Installing & Configuring DI-Updater, outlines DI-Updater server 
configuration.

• Chapter 3, The DI-Updater Interface, describes the DI-Updater Interface and each 
of its components. 

• Chapter 4, Creating & Editing Packages, details DI-Updater package creation.
• Chapter 5, Viewing & Downloading Packages, explains how to use DI-Updater on a 

client machine.

Contacting Support 1
Customer support is available from 7:00 AM to 5:00 PM (Central Time).

Table 1-1: Technical Support Contact Information

Customer Type Phone Fax Email

Domestic Users 920-436-8299 920-433-2378 support@dimins.com

International Users +1-920-436-8299 +1-920-433-2378 international@dimins.com
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What is DI-Updater? 1
DI-Updater is a DiveLine client for Microsoft Windows. It allows a Server administrator to give a 
DiveLine administrator the ability to grant access to any file from the DiveLine server for 
end-users to download for offline use.
The file types that a DiveLine administrator might want to allow a user to download include, but 
are not limited to, Models, Documentation, Installation files, Release Notes, and Graphics. Access 
to these files is independent of DiveLine’s Access Control Lists.

Useful Definition 1
Server Administrator - The administrator of the actual server that DiveLine is running on, 
typically a network administrator within your company. (The Server administrator may or may not 
be the administrator of the DiveLine application). The Server administrator is responsible for 
granting access to various directories on the server to the DiveLine administrator, via a file named 
access.txt, as well as creating any network shares and setting the network authority necessary to 
allow file download by the specified users.
DiveLine Administrator - The administrator of the DiveLine application. The DiveLine 
administrator is responsible for DiveLine configuration, as well as for the creation of file packages 
for user download in DI-Updater.
DiveLine Server - The name and port number of the server that DiveLine is running on.
Package - A file or group of files configured by the DiveLine administrator for user download.
Home Location - The location of the DI-Update directory. The default is C:\Program 
Files\DI-Update.
Package Location - The Download Location used by a package.
Download Location - The location on the client machine to which packages will be downloaded.
Install Location - The full path of the Download Location and its subdirectories to which a 
package will be downloaded on the client machine.
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DI-Updater files 1
DI-Updater files exist on both the server and client machines. Each is listed and described in the 
following sections.

Server Files 1
access.txt - Located in the \dl-dataroot\config directory, access.txt is a tab-delimited text file 
containing the list of server directories that the DiveLine administrator is able to use to create 
download packages.
.defn files - Located in the \dl-dataroot\update directory, .defn files contain all information 
defined for a package in the DI-Updater interface. The .defn files are read by DI-Updater to 
determine the packages that are listed for user download, the files each of those packages contains, 
and the location(s) of files within the package.
server.cfg - Located in the \dl-dataroot\update directory, server.cfg contains a list of all 
.defn files and the users or groups that have access to the package referred to by each .defn 
file.
update.cfg - Located in the \DI-Update\config directory, update.cfg contains the name and 
location of all download locations available in DI-Updater.
.info files - Located in the \DI-Update\config directory, .info files contain general information 
about the files included in a particular download package. (The .info files are only for 
informational purposes and should not be confused with .defn files described above.)

Client Files 1
.ulk file - A .ulk file is associated with DI-Updater. When DI-Updater is run, it opens the .ulk 
file and connects to the appropriate DiveLine server. The .ulk files are automatically associated 
with Updater.

DiveLine should be installed and configured for your users before 
configuring DI-Updater.
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Chapter 2
Installing & Configuring 
DI-Updater 2

This chapter provides information about how to install and configure DI-Updater on a DiveLine 
server.

Installing & Configuring DI-Updater on the 
DiveLine Server 2
This installation assumes that your \DI_Solution directory is on your C:\ drive.

1. Create a new folder called C:\Documents.

2. Create and put a new file named access.txt in the C:\DI_Solution\dl-dataroot\config 
directory.

The access.txt file is a tab-delimited text file that contains the list of server directories 
the DiveLine administrator is able to use to create download packages. It is created 
manually in a text editor by the Server administrator and should appear similar to the 
following: 

Download C:\DI_Solution\dl-dataroot\download
Documentation C:\DI_Solution\documentation
Release Notes C:\DI_Solution\release_notes
Other Documents C:\Documents 
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Keep the following points in mind:

• Paths may vary according to your server
• Each aliased server directory must be shared for all users that will be 

downloading packages containing files from those directories (although 
individual files within the directories can be restricted). The access.txt file 
should contain, at the very least, an alias for the \dl-dataroot\download 
directory.

• Aliases that are added to access.txt DO NOT need to be set in DI-Config. They 
function independently of DiveLine aliases.

• The user running the DiveLine service MUST have read access to the 
access.txt file.

3. Create a directory in the DiveLine dataroot named “update”. The location of this 
directory should be C:\DI_Solution\dl-dataroot\update. This is the location of the 
server.cfg file, which stores the list of definition files for each package available for 
download.

The user running the DiveLine service MUST have read and write access to 
the C:\DI_Solution\dl-dataroot\update directory.

4. Double-click di-updater.exe.

The first time DI-Updater is run, it will prompt for the location of the DI-Update 
directory. The default location is C:\Program Files\DI-Update, but should be changed to 
C:\DI_Solution\DI-Update when installing on the DiveLine server.

In addition, it will look for: C:\Windows\diver.ini, in which it will create the entry:

[Updater]  
Previous6.3DiveLine1=<servername>:<portnum>  
Default Updater Server=<servername>:<portnum>

where <servername> is the DiveLine server selected for your Updater connection, and 
<portnum> is the port that DiveLine is running on.

DI-Updater will also try to create the following folders and files: 
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C:\DI_Solution\DI-Update  
C:\DI_Solution\DI-Update\config  
C:\DI_Solution\DI-Update\config\update.cfg  
C:\DI_Solution\DI-Update\temp

The DI-Update directory is the “Home” directory where configuration and temporary 
files are stored. By default, it is also the destination for packages without unique install 
locations. This value may be changed from within DI-Updater (File >Preferences).

5. When prompted, enter the DiveLine server and port to connect to, in the format of 
<servername>:<portnum>.

6. Login using your administrative DiveLine user name and password to ensure that the 
software correctly connects to the DiveLine server.

Steps 4-6 will also be done on the client machine (see Chapter 5, Viewing 
& Downloading Packages), and the location specified in step 4 will be the 
default download location on the client machine.

7. Close DI-Updater.
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Chapter 3
The DI-Updater Interface 3

This chapter described the DI-Updater interface and its usage.

Login Screen 3
When running DI-Updater on a client or server machine, you will be prompted with the following 
DiveLine server login screen:

Enter your DiveLine Username and Password and click OK to connect. 
Clicking Cancel will open the Select DiveLine Server... dialog (shown on page 3-6), allowing you 
to enter a different server name and port number for the DiveLine server you wish to connect to.
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Startup Screen 3
After logging in, you will see the following startup screen:

Alternatively, once packages have been configured (see Chapter 4, Creating & Editing 
Packages), you will be presented with something similar to the following after login:
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Updates Available Area 3
• Package Name - Shows a list of the names of all packages available for download. 

Users will only see packages for which they have been granted access.
• Size - Shows the size of the specified package.
• Estimated Time - Shows the estimated amount of time it will take for the named 

package to download.
• Last Modified - Shows the last time the package was changed.
• Start Update - This button starts the download of the selected package or packages. 

Corresponds to the Action > Start Update menu item.
• Show/Hide Details - This button displays or hides the Update Details area of the 

DI-Updater startup screen.

Previously downloaded packages are also listed, without check boxes, and 
are sorted to the bottom of the package list.
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Update Details Area 3
If the Show Details button has been clicked, the initial startup screen will expand to display the 
Update Details Area shown here.

• Name - Lists the name of each file included in the currently highlighted package.
• Install Location - Lists the full path (the Download Location and its subdirectories) to 

which a package will be downloaded on the client machine.
• Size - Lists the size of the specified file.
• Status - Shows whether or not an update of the specified file is needed.
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Menus 3
DI-Updater contains four menus. File, Edit, Actions, and Help.

File Menu 3

Open Home Location... 3
When selected, Open Home Location will open an Explorer window to the location of the 
DI-Update directory on the DiveLine server.
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Open Package Location... 3
When selected, Open Package Location will open an Explorer window to the Download Location 
used by a package.

Change DiveLine Server... 3
Change DiveLine Server... opens the Select DiveLine Server... dialog, allowing you to specify the 
server name and port number of a different DiveLine server.
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Preferences... 3
The Preferences... menu option allows you to change the Default DiveLine Server that 
DI-Updater connects to, and to choose a Home Directory for DI-Updater.

Exit 3
Exit closes the DI-Updater application.
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Edit Menu 3

Edit Download Locations... 3
The DI-Updater end user can use the File > Edit Download Locations... menu item to edit the 
path of any existing Download Location.

Clicking the Open Location button will open an Explorer window to the location of the selected 
Download Location on the client computer.
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Clicking the Change Location button will open a dialog allowing the user to browse to a new 
location for the selected Download Location.

 
New Download Locations can only be created by a DiveLine administrator. When a DiveLine 
administrator creates a new package, and a Download Location that is not yet defined on the client 
machine has been specified, the user will be prompted to enter a directory path for this new 
Download Location, as shown below:

The new Download Location will now appear in the list of Download Locations on the client 
computer.

Actions Menu 3

Select All Packages 3
Selects all packages available for update by placing a check in the checkbox next to the package 
names. (This can also be done manually, by checking each checkbox.)



3-10 The DI-Updater Interface

Menus Actions Menu

DI-UPDATER

Unselect Packages 3
Unchecks all selected packages.

Start Update... 3
Starts the download of all selected packages.

Edit Packages... 3
Available for DiveLine admin users only, the Edit Packages... menu item allows you to create, edit, 
and delete the packages that are available to users for download. For more information, see 
Chapter 4, Creating & Editing Packages.

Refresh 3
Refreshes the list of available updates.

Selecting the Refresh menu item will unselect all currently selected 
packages.
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Help Menu 3

About DI-Updater... 3
Provides information about the version of DI-Updater and the version, server name, and port 
number of the DiveLine server that DI-Updater is currently connected to.
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Chapter 4
Creating & Editing 
Packages 4

This chapter describes the process for creating and editing DI-Updater file packages on the 
Diveline server for end-users to download from their desktops.

1. Start DI-Updater by double-clicking the executable.

2. Go to Actions > Edit Packages... to open the Edit Packages dialog.
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3. Click New... to open the Edit Files dialog.

4. Enter the desired name in the Package Name: text box. This might be something like 
“Documentation”.

5. Enter the name of the desired Download Location in the Download Location Name: 
text box. This might be something like “Updater Download”. 

If the specified download location does not exist on the client machine, the 
user will be prompted to browse to the desired location for the download 
location. The new download location will then appear in the Edit > Edit 
Download Locations... list for the client machine.

6. Enter text that briefly describes the purpose or contents of the package in the 
Description: text box. This might be something like “DI software user documentation”.
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7. Enter the path of any subdirectories of the Download Location that should be created 
when the package is download in the Subdirectory: text box. This might be something 
like: /documentation. (Back slashes, rather than forward slashes, must be used when 
defining this path.)

8. Click the Add button to open the Edit File dialog and add new files to the package.

9. Select the Updater Alias from which to obtain files. (The list of available aliases is 
determined by the directories set in the access.txt file by the server administrator.)

10. Click Browse to view the Open File dialog. Select the file(s) to be added and click Open 
then OK.
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This dialog allows multiple file selection using the Ctrl or Shift keys. The 
list of files will appear in the dialog edit box as a space-delimited set of 
quoted strings. For example: “aaaa.mdl” “bbbb.mdl” “cccc.mdl”. When the 
you click “Open”, each selected file will be added as a new entry in the 
package file list view. The package file list view also allows multiple 
selections for deleting a large number of files.

11. Once all needed text fields have been filled in and all necessary files have been added to 
the package as shown below, click Save and select Yes to commit changes to the server.

12. Click Cancel then Close to return to the Edit Packages dialog.
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You will now see the newly created Package.

To edit the contents of a package from the Edit Files dialog: 

1. Select the package.

2. Click Edit

3. Make the needed changes

4. Click Save

5. Select Yes.

To remove a package, select it and click Remove.
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Once a package has been created, user access to the package must now be configured so that users 
or groups of users are able to download it.

1. Highlight the package name in the Edit Packages dialog and Click User Access... to 
open the Edit Users dialog.

2. To grant access to a user or list of users, click Add User... and select the desired user 
from the User Name pulldown. Click OK.

3. Repeat until all necessary users have been added.
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4. To grant access to a group or list of groups, click Add Group... and select the desired 
group from the Group Name pulldown. Click OK.

5. Repeat until all necessary groups have been added.

6. Click Save and select Yes to commit changes to the server.

7. Click Close to return to the Edit Packages dialog.

DI-Updater access to a Model via a download package is independent of 
download access granted to a user in DI-Config.

User access to files using DI-Updater is stored as part of the download 
package and is NOT affected or controlled by DiveLine ACL’s.

When a Model is included in a package, all continuation files are 
automatically included.
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Chapter 5
Viewing & Downloading 
Packages 5

This chapter describes the steps to view and to download DI-Updater packages to a client machine.

1. Double-click updater.exe.
The first time DI-Updater is run, it will prompt for the location of the DI-Update 
directory. The default location is C:\Program Files\DI-Update.

In addition, it will look for: C:\Windows\diver.ini, in which it will create the entry:

[Updater]  
Previous6.3DiveLine1=<servername>:<portnum>  
Default Updater Server=<servername>:<portnum>

where <servername> is the DiveLine server selected for your Updater connection, and 
<portnum> is the port DiveLine is running on.

2. Enter the DiveLine server and port to connect to, in the format 
<servername>:<portnum>. For example:
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3. Login using your DiveLine username and password.

4. Select the package(s) to be downloaded by placing a check in the box next to each 
desired package name. You can select all available packages using the Actions > Select 
All Packages menu item.

5. Click the Start Update... button, or select Actions > Start Update...

6. If prompted, browse to the desired location for any new download locations and click 
OK.
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Once the update is complete, you will be able to access all files within the downloaded packages 
in the specified download locations.
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